Terrain Navigator Pro
Search & Rescue and Emergency Management
Reference Guide & Training Manual

Ed Lecuyer
TNP Technical Product Manager
Contributors:
§ Sam Chan
§ Nancy Culberson
§ Rick Hood
§ Monica McFadden
§ Rick Najarian
§ Dan Ragen
Last Revised: 2/27/2013
For Terrain Navigator Pro Version 9.21

Terrain Navigator Pro SAR Workbook

2

Table of Contents
Introduction ..................................................................................................................................... 3
Getting Help with Terrain Navigator Pro ........................................................................................................ 3
Applying Software Updates and Upgrades.................................................................................................... 3
Technical Support .......................................................................................................................................... 3
Sales Support ................................................................................................................................................ 4
Annual Subscription ....................................................................................................................................... 4
A note regarding software piracy ................................................................................................................... 4

Part 1: Basic TNP for SAR .............................................................................................................. 5
What is Terrain Navigator Pro? ..................................................................................................................... 5
How is TNP useful for SAR?.......................................................................................................................... 5
Opening Maps................................................................................................................................................ 6
Finding Locations........................................................................................................................................... 6
Setting up TNP – Your Preferences .............................................................................................................. 7
Bookmarking Locations.................................................................................................................................. 9
Basic Tools: Measuring Distances, Area, Profile and Line of Sight .............................................................. 9
Starting a Search: Creating a Project .......................................................................................................... 10
What Are Layers? ........................................................................................................................................ 10
Using Markers.............................................................................................................................................. 11
Using Routes ............................................................................................................................................... 13
Using Tracks ................................................................................................................................................ 14
Using Labels ................................................................................................................................................ 15
Finding Layers (Markers, Tracks, etc) within a Project................................................................................ 15
Layer Size/Visibility: Keep the Map Clean ................................................................................................... 16
GPS Setup ................................................................................................................................................... 16
General SAR GPS Tips ............................................................................................................................... 17
GPS and Tracks........................................................................................................................................... 17
GPS and Waypoints..................................................................................................................................... 18
Basic Printing ............................................................................................................................................... 19
Downloading Aerial Photos Before the Mission........................................................................................... 19
Switching Coordinate Systems .................................................................................................................... 20
TNP Mobile App Basics ............................................................................................................................... 21

Part 2: Advanced TNP for SAR ..................................................................................................... 22
Two-Window Mode ...................................................................................................................................... 22
Using Range Rings ...................................................................................................................................... 22
Using RBLs .................................................................................................................................................. 23
Using GeoPins ............................................................................................................................................. 24
Using Overlays............................................................................................................................................. 25
Advanced Track Editing ............................................................................................................................... 25
More Symbols and Line Styles: The Emergency Management Symbol Pack ............................................ 26
Useful Tips and Tricks ................................................................................................................................. 27
Advanced Printing........................................................................................................................................ 27
Advanced Publishing (Exporting) of Maps................................................................................................... 28
Using TNP with Google Earth ...................................................................................................................... 28
Sharing Layers and Projects: Basic Import & Export................................................................................... 29
Advanced Connectivity: Project Synchronization ........................................................................................ 29
Advanced GPS: Sending Markers, Routes, Tracks to the GPS .................................................................. 31
Advanced GPS: Creating Custom Maps ..................................................................................................... 31
Advanced GPS: Using Uncommon GPSs ................................................................................................... 33
Advanced GPS: Live Position Tracking ....................................................................................................... 33
Connecting with TNP Mobile – an Alternative to Handheld GPSs .............................................................. 33
Team Tracking ............................................................................................................................................. 34

Terrain Navigator Pro SAR Workbook

Introduction
Here are some basic tips for getting started with Terrain Navigator Pro.

Getting Help with Terrain Navigator Pro
•

Every Window in TNP has a Help button. If you are unsure about a feature, press it and
the relevant manual page will open.

•

Hover mouse over buttons to display tool tips. Also, menu items are described on the help
line on the dashboard at the bottom of the map display.

•

Open the Help menu and choose Contents. Everything is covered in detail. Sections are
broken up into "books" and hot links are throughout. It's just like surfing the web.

•

In the Help, check out the topics under: Getting Started, The Basics. It covers most
everything you need to know in a handful of help pages.

•

Prefer a printed manual? There is a PDF edition of the help document available on the
Installer DVD. It can also be downloaded at: www.mytopo.com/tnp

•

A whole library of Technical Documents are available at: www.mytopo.com/tnp

Applying Software Updates and Upgrades
•

Software upgrades are very important. Always ensure you have the latest software.

•

Starting with version 9.1, software updates occur automatically. Or, open the File menu,
choose Preferences, Internet Access and Map Cache, and press Check Now.

•

Street updates come on Installer DVDs which are received upon subscription renewal (see
below.) Run this disc (even if you have the latest software) to update the street overlay.

•

Map updates are delivered via the Internet. Open the File menu and choose Map and
Aerial Updates via Web. Note that topo maps are not often updated. Aerial photos are
updated usually every two years.

•

Other updates may be available by logging into your Registration account, or by visiting
the Downloads section of www.mytopo.com/tnp

Technical Support
•

Send emails to tnp@mytopo.com

•

Call us at 877-587-9004

•

Visit www.mytopo.com/tnp
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Sales Support
•

Ken Zisserson is your sales rep.

•

Call 877-587-9004 x106

•

Email ken@mytopo.com

•

SAR Discounts available – please call Ken for details and a price quote.

Annual Subscription
•

Entitles you to software upgrades, aerial photos, alternate map/aerial photo editions,
map/photo updates, mobile app (iPhone, Android) synchronization, unlimited technical
support, and more!

•

Cost is $99 per year (per state.) SAR discounts are not available.

•

To renew: visit www.mytopo.com/tnp and log into your Registration account or call 877587-9004.

A note regarding software piracy
MyTopo, (now a Trimble company) is proud that Terrain Navigator Pro is used in the important task
of Search and Rescue. To that end, we are pleased to make the TNP available at a discount to
qualified SAR groups, and has been willing to customize its features to streamline its use for SAR.
Many members of the TNP beta test team are active SAR volunteers, and their feedback helps to
shape its further development.
In order for this partnership to continue, please do not share TNP (or its plug-ins, or updated
software) with those who did not purchase it. Instead encourage them to call us, and we will be
happy to discuss their specific needs and situation.
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Part 1: Basic TNP for SAR
What is Terrain Navigator Pro?
•

Terrain Navigator Pro (TNP) is general-purpose mapping/GIS application.

•

TNP has many uses (hiking, surveying, property management) besides SAR.

•

Because of its versatility, TNP has become the standard within the SAR community.

•

1:24,000 USGS topographic base maps included – no downloads required. The 1:24,000
USGS topographic map (also called a "7.5-Minute Quad") is the standard for SAR.

•

Integrated 1:12,000 Aerial Photos – download required. These can be helpful as they are
typically more updated than the USGS map, they also may have more detail.

•

Other map types and editions available: 1:100,000 topographic, 1:250,000 topographic,
1:24,000 shaded relief, 1:7600 aerial photos, 1:3600 aerial photos, historic aerial photos.

•

Current street overlay appears over older USGS topos and aerial photos – allowing for
updated maps.

•

TNP includes powerful tools to annotate, customize, and print the maps.

•

TNP integrates with handheld GPS units.

•

TNP mobile app available for iPhone and Android devices.

•

TNP can serve as mission log for SAR activities.

How is TNP useful for SAR?
•

Real-time search
Customize map for search area.
Use maps/3D to determine probable paths the subject may have taken.
Use Range Rings on last known position to determine scope of search area.
Segment search area using route tool.
Print maps for search teams.
Verify team positions through team tracker module.

•

Evidence search
Use markers to indicate positions of evidence.
Use mobile app to take geo-tagged photos and videos of evidence.

•

Mission logging and documentation
Gather tracks recorded by handheld GPSs.
Log evidence using markers.
Use Projects to keep an archive of past searches.
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Opening Maps
•

When TNP starts, the Open Map window is displayed. Use the CD Library button to switch
to the desired state. Double-click on any map grid to open the corresponding USGS map
for that area.

•

To return to the Open Map window, choose Open Map from the File menu, press the
Map Selector button on the toolbar:
bar) that points at the state.

, or click the

button (on the compass control

•

When a map is open, at the top of the screen is the menu and tool bar. Use these to
switch between the tools and maps available. Also note the coordinate and elevation
display – these are updated as the cursor is moved over the map.

•

To switch map types/scales/editions, press the Map Type button on the toolbar:
Maps and aerial photos are used interchangeably in TNP – everything that
applies to a USGS topographic map also applies when an aerial photo is in view.

•

To zoom in and out (without changing map type/scale) use the Zoom button:

•

Use the Drag (hand) tool to pan around the map:

•

Use the information tool:
to get basic map information (contour interval, date
created.) The Information tool can also be used on all layers (markers, tracks, etc.)

•

Press the Toggle 3-D View button:
it again to leave the 3-D view.

to display the active map (or photo) in 3D. Press

Finding Locations
•

Use the Find menu (or the Find button in the Open Map window) to open the map to a
desired address, place of interest, coordinate, etc.

•

To find by street address:

•

1. Use the CD Library button in the Open Map window (or the Change CD option in the
File menu) to switch to the desired state.
2. Open the Find menu (or press the Find button in the Open Map window.)
3. Select Street Address.
4. Enter the address and city (or zip).
5. Press Replace Active (or OK if no map is open.)
To find a place of interest:
1. Use the CD Library button in the Open Map window (or the Change CD option in the
File menu) to switch to the desired state.
2. Open the Find menu (or press the Find button in the Open Map window.)
3. Select Search All Placenames. Shortcut: use the Find Place button:
4. Enter an appropriate keyword (name of the feature, etc.) i.e. Pink Beds or Eno River
(Partial information can be entered; a listing of close matches will appear from which
you may select.)
5. Press Find.
6. A list of matches will be displayed. Select the desired place name.
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•

7. Press Replace Active (or Open if no map is open.)
To find by coordinates:
1.
2.
3.
4.
5.

•

•

Open the Find menu (or press the Find button in the Open Map window.)
Select Coordinates.
Set the Format to the type of coordinates (UTM, Lat/Lon, etc.)
Enter the coordinates.
Specify the datum the coordinates are in. (Be sure to double-check – especially when
using UTM.)
6. Press Replace Active (or Open if no map is open.)
Other Find items available:
City/Town
Zip Code
GNIS Categories (Airport, Hospital, Lake, etc.)
Layers you have created in this project (covered later)
Map by name or USGS reference code
Previous 5 locations found
The red Find Circle will appear around the object/location that was found. Click on it to
remove it from view.

Setting up TNP – Your Preferences
•

Preferences are used to tailor TNP to your needs. TNP "out of the box" may be tweaked
to operate in an optimum way for your team. Be aware of the options available to you, and
how these can be used for your needs.

•

Some teams have a standard set of suggested preferences.

•

Preferences are segmented into categories.

•

Open Preferences under the File menu, or press the Preferences button:

•

Switch between categories in File/Preferences, or by choosing from the drop down list at
the top of the Preferences window.

•

Suggested Coordinate Preferences:
1. Primary Coordinate Display, Format: UTM
-or- USNG
2. Primary Coordinate Display, Datum: NAD83 (or WGS84)
3. Alternate Coordinate Display, Format: Dº M.M’ (Lat/Lon, Decimal minutes)
-or- D.Dº (Lat/Lon, Decimal degrees)
4. Alternate Coordinate Display, Datum: NAD83 (or WGS84)
5. Bearing Display Variance: True or Magnetic – depending on situation.
6. Distance Display, Units: English
7. Elevation Display, Units: English
Notes:
Air patrols typically use Dº M.M' (Lat/Lon, Decimal minutes) as their coordinate standard.
NAD83 and WGS84 are equivalent datums in North America.
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•

Suggested General Preferences:
1. If you prefer larger buttons: Set Toolbar and dashboard controls, buttons to Larger
size. This is also useful when using TNP on a touchscreen PC.
2. If you wish to maximize map area, consider turning off: Show Compass Bar, Show
GPS status line, and No Help Line or Status Lights (for the Dashboard.)
3. If using a touchscreen computer, turn on Show Mouse Swap button (to allow the use
of the finger to right-click objects on the map.

•

Suggested GPS Setup Preferences:
1. Set the Manufacturer to Garmin.
2. Set the Unit to the GPSmap 62s USB or the GPSmap 60csx USB – depending on what
is more common to your team. Or, pick the GPS that best suits your situation.

•

Suggested Internet Access and Map Cache Preferences:
1. When using TNP without an Internet connection, turn off Allow Terrain Navigator to
connect to the Internet. DON'T FORGET TO TURN THIS OPTION BACK ON when
you are back online!
2. If you have copied the aerial photos to the hard drive (covered below) consider
turning off the option to Check for updated aerial photos and add them to the
cache. Otherwise, the older photos that were copied to the hard drive will be ignored,
and the newer photos will be downloaded and displayed.
3. Set the Map/Aerial Photo Cache Size to 64 GB – if you are using the aerial photos,
this will improve performance and reliability, provided that you have the available hard
disk space.

•

Suggested Layer Size/Visibility Preferences:
1. In the Layer Size, turn off the option to Conform layer size to map scale. Otherwise
your markers, tracks, etc., will size according to the map scale – which is generally not
desirable for SAR applications.
2. In Layer Visibility, turn off Benchmarks. These are usually used by surveyors and
clutter the map unnecessarily in SAR applications.
3. In Layer Visibility, see how the Streets layer can be turned on and off. This is useful
when the streets clutter the map.
Notes:
Use Layer Size/Visibility to "de-clutter" your map (covered later.)
There is a button for the Layer Size/Visibility preference on the toolbar:

•

Suggested Range Rings Preferences:
1. In the Display Defaults, set the No. of Rings to 1. In most circumstances, you will only
need a single ring.

•

Suggested Tracks Preferences:
1. In GPS/GPX Transfer, turn on the preference to Prompt to rename track upon receipt
from GPS. This will allow you to identify tracks from the various search teams as they
are received into TNP at the command post.
2. In GPS/GPX Transfer, turn off the preference to Combine segments into single track
upon receipt/import. Otherwise, track segments will be combined together.
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Bookmarking Locations
•

Use Bookmarks to save map views – like bookmarks on the web.

•

In SAR, a Bookmark may be generated for the command post, place last seen, etc.

•

To create a Bookmark:
1. Navigate to the spot on the map you wish to bookmark.
2. Open the View menu and choose Bookmark this View.
3. Name the bookmark. Add notes if desired. Press OK.

•

To open a Bookmark:
1. Open the Find menu and choose Bookmark.
2. Select the desired bookmark from the list of available bookmarks.
3. Press Replace Active (or Open if no map is open.)

Basic Tools: Measuring Distances, Area, Profile and Line of Sight
•

Use the Distance Tool:

•

The Distance Tool has two modes, straight line and freehand.

•

Refer to the Help line on the dashboard (below the map) to see the distance as the tool is
used. The straight line mode will also show bearings.

•

Make a mistake? Use the Backspace key to back up.

•

Right click on the distance line that you have created and choose Information to display

for quick measurements.

distance, etc. Or press the Information button:
•

To create a profile, display the Information, then press Profile. Or right click on the
distance line and choose Profile. Or press the Profile button:

•

To show line of sight, right click on the distance line and choose Line of Sight. Or press
the Line of Sight button:

•

To measure area, click the end point to the start, then display the Information. Be careful
not to cross the distance line over itself, otherwise the area can not be computed.

•

Want to clear the distance tool? Right click on the distance line and choose Clear. Or
Press the Delete button:

•

When finished measuring distances, switch back to the Drag tool:

•

The distance line is a "fleeting" tool. It is for quick measurements. The distance line is not
saved between sessions of TNP. You can, however, convert a distance line to a track or
route by right clicking on it.
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Starting a Search: Creating a Project
•

Think of a Project as a collection of all the items related to the search. Everything that
you place on the map, and all information logged will be stored into this Project.

•

Projects can be recalled at any time for reference.

•

Projects can be archived and kept in case they are needed later.

•

To create a Project:
1.
2.
3.
4.
5.

•

Open the Layers menu and choose My Projects.
Press the New button
Name the project, press OK.
Close the My Projects window.
The project name will now be indicated in the TNP title bar (above the buttons.)

Use a Naming Convention for Projects
1. Suggestion: Name of missing person(s) Search date search started
2. Example: Conne Family Search-1-30-12
Note: Cannot use "/" symbol
3. Use the Notes field to add additional details – start keeping a log.

•

To switch between projects:

1. Open the Layers menu and choose My Projects.
2. Select the desired project from the list of Available Projects
3. Close the My Projects window.
4. The active project name will now be indicated in the TNP title bar (above the buttons.)
Note: Layers (markers, tracks, etc.) are stored within their respective project. Be sure you have
the correct project active before making additions or changes to the map.

What Are Layers?
Layers are anything added to the base map.
• In Terrain Navigator Pro, there are various ways to make modifications to the USGS
maps and aerial photos. These modifications are stored as Layers, which are saved
automatically as they are created.
•

There are two basic types of layers. Some, such as markers, routes, and tracks, you
create. Others, such as the street layer or custom grids, are added automatically. All of
the layers can be identified and controlled by opening the View menu and choosing Layer
Size/Visibility.

•

Currently, there are seven types of layers that can be used to directly annotate maps:
Markers, Routes, Tracks, Labels, Range Rings, Range/Bearing Lines, and GeoPins.
With these layer tools, a wide variety of edits can be performed on the maps.
1. Markers are single positions on the map. Each marker can have a unique symbol and
color. Markers also contain a text label. Markers are useful for noting single objects on
the map such as the LKP, command post, a parking lot, or a campsite.
2. Routes consist of waypoints, connected by legs. A waypoint is a location along the
route where a direction change takes place. While Routes are often used to plan hikes,
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3.

4.

5.

6.

7.

where you have a starting point, one or more stopping points (summit, lunch break,
etc.), and an end point, routes can also be used to search segments/sectors.
Tracks are free-form routes without waypoints. They can be drawn on the map in a
variety of colors. Tracks are often used to illustrate trails, streams, and roads. Tracks
are also gathered from GPS units to illustrate where a search team has been.
Labels are text annotations. They can be constructed with various outlines,
backgrounds, etc. They are most useful to work around the limitations found in the builtin labels on markers and route waypoints.
Range Rings are concentric circles and are used to note distances from a point of
origin. These are commonly placed at the LKP, and computed to show the maximum
scope of the search area. (These are discussed in the advanced section of this training
manual.)
Range/Bearing Lines are used to measure distances by heading, speed, time, etc.
Two RBLs can be used to show points of intersection. (These are discussed in the
advanced section of this training manual.)
GeoPins are shortcuts to web sites, documents, photos, and other files on your PC.
They can be used to display pictures of evidence gathered, or other documents related
to the search. (These are discussed in the advanced section of this training manual.)

All of these Layers can be placed on the map by selecting the desired tool and clicking on the map.

Using Markers
Markers are to notate single positions on the map.
Markers are used to indicate evidence, clues, LKP, PLS, etc. Other useful things to notate
include the command post, other facilities, traffic flow/parking, relevant hazards, checkpoints,
etc.
•

To create a marker:
1.
2.
3.
4.

Click the marker tool:
The mouse cursor will change to a triangle.
Position the mouse cursor over the spot where you would like to create the marker.
Click the mouse.

5. When finished creating markers, switch back to the Drag tool:
•

To move a marker:
1. Click the marker tool: (if not already selected)
2. Position the mouse cursor over the existing marker. The cursor will change to a marker
with a hand.
3. Click and drag the marker to the new location.

•

To prevent further movement of a marker:
1. Right click on the marker.
2. Choose Lock.
This is HIGHLY RECOMMENDED to prevent accidental movement of critical information.
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•

To name a marker:
1. Click the marker tool: (if not already selected)
2. Position the mouse cursor over the existing marker name. The cursor will change to an
I-beam.
3. Click and edit the marker name.
4. When finished, click outside of the edit area, or press Enter.
Note: Use a naming convention. May want to include the date as part of the name, so to
be able to identify it during a multi-day search.

•

To modify a marker:
1. Right click on the marker and select Edit Marker.
2. Change name, symbol, color, etc.
3. Add Notes – keep a log of all relevant information.

•

Suggested Markers for SAR:
Use standard markings whenever possible:

1. Incident Command Post: l , Staging Area: n, Base: f
2. Incident Location: o - IPP (LKP or PLS)
3. Traffic flow/parking, drop off, pick up, support
4. Relevant hazards to searchers, Safety path – if relevant
5. Check Points
6. Other facilities and key features: camps, helispot
7. Attractors/barriers due to subject profile or other vetted information
Note: Don’t overload the map with markings.
Bottom line: Can someone else read, utilize, and leverage your map markings?
•

To Find a Marker
1.
2.
3.
4.

Open the Find menu and choose Marker.
Select All Markers (if needed)
Click the desired marker (you did name it, right?)
Press Replace Active (or Open if no map is open.)
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Using Routes
Routes are to notate lines and areas/polygons on the map.
The Route tool is the best tool to use to lay out search segments/sectors. It can also be
used to draw boundaries, roads, fences, etc.
•

To create a route:
1. Click the route tool:
2. The mouse cursor will change to a triangle.
3. Position the mouse cursor over the spot where you would like to create the first
waypoint (or one corner of the area.)
4. Click the mouse to place the waypoint.
5. Continue adding waypoints to create the basic shape. Details will be filled in later.
6. If creating a polygon (search segment/sector) create the last waypoint near, but not
on the first waypoint.
7. When the route/polygon is complete, right click on a waypoint and choose Finish Route.
Or, click the Finish Route button on the toolbar.
8. If creating a polygon (search segment/sector) right click on any waypoint and choose
Toggle Route Loop.
9. When finished creating routes, switch back to the Drag tool:

•

To move a waypoint:
1. Click the route tool:
(if not already selected)
2. Position the mouse cursor over the existing waypoint. The cursor will change to a
waypoint with a hand.
3. Click and drag the waypoint to the new location.

•

To refine the route:
1. Click the route tool:
(if not already selected)
2. Position the mouse cursor over a spot in the route leg. The cursor will change to a
waypoint with a +.
3. Click to create a new waypoint.
4. Drag the waypoint to a new position (if desired.)
Note: This feature is key for creating search segments – lay out the basic area, then refine.

•

To prevent further movement of a route:
1. Right click on a waypoint in the route.
2. Choose Lock Route.
This is HIGHLY RECOMMENDED to prevent accidental movement of critical information.

•

To modify a route:
1. Right click on a waypoint in the route and select Edit Route.
2. Change name, line options.
3. Use Fill/Loop options on polygons (search segments/sectors) to create shaded
patterns.
4. Add Notes – keep a log of all relevant information.
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5. Turn off Display Waypoint Symbols to hide the waypoint symbols (if desired.)
6. Turn off Display Waypoint Names to hide the waypoint names (if desired.)
•

To create routes that touch/overlap:
1. Place the waypoint next to the desired location (such that the mouse cursor does not
attempt to edit/move the existing route.)
2. Move the waypoint from the spot placed, to the desired location next to, or on top of
the existing route.
Note: This feature is KEY for creating search segments – creating segments that are
adjacent to each other. This trick also works with all other layers (markers, tracks, etc.)

•

To measure the size of the search area:
1. Define the search area (or search segment) using the route tool.
from the tool bar.
2. Choose the Information tool:
3. Click on any part of the route/polygon/search segment.
4. The Information window will indicate the area.

Using Tracks
Tracks are typically used to indicate the location where a team has searched. Usually these
are gathered from handheld GPS units and downloaded to the base station computer. This
process is described later.
Tracks can also be drawn free-hand using the track tool:
While not as flexible as the route
tool, the track tool can be handy for annotating trails, streams, and other similar objects. Like
routes, tracks can also be looped to create a polygon (and used to measure area.)
•

To create a track (using the freehand track tool):
1.
2.
3.
4.
5.
6.
7.
8.

Click the route tool:
The mouse cursor will change to a pencil.
Click once to start creating the track.
Click and drag to create curved lines.
Click move and click again to create straight lines.
Use the Backspace key to back up and erase mistakes.
Click the mouse to place the waypoint.
When the track is complete, right click on the track and choose Finish Track. Or, click
the Finish Track button on the toolbar.
9. If creating a polygon right click on the track and choose Toggle Loop.
10. When finished creating tracks, switch back to the Drag tool:

•

To modify a track:
1.
2.
3.
4.

Right click on the track and select Edit Track.
Change name, line options, color, thickness, style, etc.
Use Fill/Loop options on polygons to create shaded patterns.
Add Notes – keep a log of all relevant information.
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Using Labels
Labels are typically used to annotate the map with large text descriptions. This is different
from markers. Labels are often used to note the search segment, team assignments, or other
useful information.
•

To create a label:
1.
2.
3.
4.

Click the label tool:
The mouse cursor will change to a balloon.
Click on the object you want the label to "point" to.
Click in the label area to edit its text.

5. When finished creating labels, switch back to the Drag tool:
•

To modify a label:

1. Right click on the label and select Edit Label.
2. Change the Style, Background Color, Text Color, Font, etc.
Tip: Use the label tool to get you out of a jam when markers are too close together to be
named. Instead, hide the marker's name and use the label tool to indicate the marker's name.
•

Use AutoText (in the Edit Label window) to automatically label coordinates, street
addresses, elevations, and grade. These will dynamically update when the pointer of the
label is moved.

•

Don't forget to Lock the label from movement when you are satisfied. Right click on the
label and choose lock.

•

How to label assignment names in search segments/sectors
1. Use a label style of (none) when putting a label inside a segment/sector.
2. A balloon label is good to use when labeling sectors with team assignments. You can
move the pointer anywhere on the sector and pull the balloon out of the way of the
search area, while still keeping up with whose assigned to each sector.
3. You can even update the labels with departure, call-in, and return times. This makes it
easier to keep up with team status.

Finding Layers (Markers, Tracks, etc) within a Project
•

Open the Find menu and choose the type of layer you wish to locate.

•

Local items are in the general vicinity. All items are all of those within the Project. You can
not locate items not in the active project (use My Projects in the Layers menu to switch
between projects.)

•

Press Replace Active (or Open if no map is open.)

•

You can also use the Find buttons in the Edit window for each type of layer. Open the
Layers menu and choose the desired layer type (marker, track, etc.) Then, select the object
and press Find (or Find Start for tracks and routes.)
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Layer Size/Visibility: Keep the Map Clean
•

Use the View menu.

•

View, Show Layers will hide and show all layers (leaving only the base map/photo.) This
can also be accessed using the Toggle Layers button:

•

View, Layer Size/Visibility will hide and show individual layers. This can also be
accessed under File, Preferences or by clicking the Layer Size/Visibility button:

•

To hide all layers of a type, open Layer Size/Visibility and uncheck box by name of that
layer (e.g. unchecking Streets will hide all streets.) Checking the box will show those layers.

•

To hide selected layers, open Layer Size/Visibility the name of that layer (e.g. selecting
Tracks will present a list of sub-layers: all of the tracks within the project.) Check the tracks
that you want visible. Uncheck the tracks you want hidden.

•

Use the Sizing control in Layer Size/Visibility if the map is overall too cluttered.

GPS Setup
•

All GPS functions are found in the GPS menu.

•

Use the GPS Setup Wizard to get started or to connect an unfamiliar GPS.

•

Use GPS Setup to bypass the GPS Setup Wizard and connect a known GPS. Usually,
this is much faster than using the wizard – once you know what type of GPSs to expect.

•

Modern Garmin GPSs come in two types: Garmin Protocol, and Garmin Memory Card.

•

Examples of Garmin Protocol units include:
1.
2.
3.
4.

•

•

GPSMap 60 (60s, 60csx, etc.)
Astro 220
Rino 110/120/130/530
eTrex (Legend, Vista)

Examples of Garmin Memory Card units include:
1. GPSMap 62 (62t, 62st, etc.)
2. Astro 320
3. Colorado, Oregon, Montana
4. eTrex 10/20/30
Generally speaking, all GPSs of the same protocol are cross-compatible. Thus, using
the GPSMap 62 USB setting in TNP will also communicate with an Oregon or Astro 320.
Choosing GPSMap 60 USB in TNP will also communicate with an Astro 220 or Rino 130.

•

If a GPS will not connect, try a different protocol or use the GPS Setup Wizard.

•

GPSs that use the Garmin Protocol also require a Windows driver. This is not supplied
with windows or Terrain Navigator Pro. The best way to acquire the driver – and have a
valuable tool – is to download and install Garmin BaseCamp (free) from:
http://www.garmin.com/en-US/shop/downloads/basecamp

•

Be prepared:
1. Have a backup GPS cable.
2. Have Garmin BaseCamp installed.
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General SAR GPS Tips
•

Before leaving on assignment, use your GPS to mark and name important waypoints such
as ICP, PLS, and the start of your search area.

•

In the field, it may be easier to mark a waypoint, accept the default name (such as 017) and
write it in your personal log along with the relevant notes.

•

Including the coordinates in the personal log for waypoints gathered makes it easier when
you are asked to confirm a location.

•

When coordinates are transmitted via radio, consider writing them in your log before
entering them into the GPS.

•

You can enter coordinates quickly by making a new waypoint (at the current GPS position)
then editing it to have the desired coordinate position.

•

Determine if (and where) track logs are being collected during the assignment briefing, and
whether all or some (like the middle person) are being collected.

•

Track downloads usually occur before team debrief interviews. During downloads might be
a good time to start doing the debrief paperwork.

•

Having your name and county on a permanent sticker (or at least on the welcome screen)
on the GPS is a good idea.

•

Use a removable sticker to identify the team unit, name, assignment #, and team member
name.

•

On certain older Garmin GPSs, saving a track to memory, will result in the time stamp for
the points being. Since the time stamp should be part of a search record, it is important to
not save the track to memory before being downloaded into TNP when using these GPSs.

GPS and Tracks
•

To download tracks from the GPS into Terrain Navigator Pro:
1.
2.
3.
4.
5.
6.
7.
8.

•

Connect GPS to computer with USB cable and turn on.
Open the GPS menu in TNP.
Choose GPS Setup to specify the model of GPS (if necessary.)
Choose Receive from GPS, Receive Track Logs
Window will open showing available tracks.
Click on desired track to highlight (consult with searcher if more than one track.)
Press Import (or OK, if using a Garmin Protocol GPS.)
Prompt will appear for naming the track. Name and press OK.

A suggested naming convention for tracks:
1. Team “X” (X is team number or name)
2. If specialty team (K9, ATV, Mounted, etc.), add that to Team name/number
3. Date
4. Operational period
Example: Team 4 K9 – 2-7-12-Pd.2
5. If more than one track from a team, also add (#) for as many tracks as downloading for
that team
Example: Team 4 – 2-7-12- Pd.2 (2) = 2nd track from team 2.
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•

Another suggested naming convention for tracks:
1. Operational Period "O#" (# is the operational period 1-9, or 10+ if needed)
2. Assignments "A##" (## is the assignment within the operational period 01-99)
3. Team "T##" (## is the team number 01-99, if not a specialty team)
4. Multiple tracks from same team "y" (y is a-z, 'a' may be reserved as team leader.
Example: O1A01T1a
5. Specialty teams (K9, CAT, MSAR, LE, SO, AIR) should be substituted for T where
appropriate.
Examples: O2A25AIR1 O5A14K94

•

Right click on the track and choose Edit Track to change its color. This is recommended
to visually distinguish between search teams.

•

Right click on the track and choose Edit Track to change its name and enter notes
regarding the track. Use the notes field to log information regarding that team's search.

•

More Tips:
1. Be sure to turn on the Tracks Preference to Prompt to rename track upon receipt
from GPS. This will remind you to identify tracks from the various search teams as they
are received into TNP at the command post.
2. Renaming track downloads is essential to avoid confusion. For searches involving
multiple operational periods, assignments, and teams, using a consistent system from
the first track download eliminates the problem. A logical naming convention allows
tracks to be listed in a predictable order so that large lists are manageable. In a good
naming convention, unique track log names are created even if team names or
assignment numbers are repeated – without having to review existing track log names.
3. Use GPS Setup to switch between GPS units.
4. When finished using Garmin Protocol GPSs (such as the GPSMap 60) open the
GPS menu and uncheck Connect. Otherwise TNP will continue to attempt to
communicate with the GPS – which can reduce the performance of the software.
5. Having trouble connecting to a particular Garmin GPS? Try connecting to BaseCamp.

GPS and Waypoints
•

To download wayponts (markers) from the GPS into Terrain Navigator Pro:
1.
2.
3.
4.
5.
6.

Connect GPS to computer with USB cable and turn on.
Open the GPS menu in TNP.
Choose GPS Setup to specify the model of GPS (if necessary.)
Choose Receive from GPS, Receive Waypoints.
Window will open showing available waypoints.
Click on desired waypoint(s) to highlight. Use CTRL key to select more than one
waypoint.
7. Press Import (or OK, if using a Garmin Protocol GPS.)
8. Waypoints will appear as markers in TNP.
•

Be sure to name (and enter notes) for any waypoints gathered.

•

Use proper symbols for various objects.

•

Lock the marker from accidental movement once it is complete.
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Basic Printing
•

Open the File menu and choose Print, or press the Print button:

•

For basic SAR use, use the Basic SAR Map Template:
1. In the Print window, open the Templates tab.
2. In the list of available templates, choose Basic SAR Map.
3. Press Load.

•

Use the Properties tab to perform basic changes to the map:
1. Set the Map as the active Page Block to see the properties that are map-related.
2. Map Type: Commonly switch between Topographic (1:24,000) and Aerial Photo
(1:12,000) – although other types/scales are available.
3. Use Size to create maps that are zoomed in and out.
Suggested types and sizes:
⇒ Street map for urban searches. (Set the Map Type to No Map)
⇒ Topographic 1:24,000 at 100% size
⇒ Topographic 1:24,000 at 200%-400% size (based on search area.)
⇒ Aerial Photo 1:12,000 at 100% size
⇒ Topographic 1:24,000 at 200%-400% size (based on team assignments/search
segments.)

•

Use Layers controls like Layer Size/Visibility in the main map window:
1. Turn off all layers
2. Select specific layers to show and hide on the map.
3. Size the layers if the map is too cluttered.

•

Click and drag the map in the preview area to move the map around.

•

DON'T CLICK the black boxes – these will move the page blocks. (Editing page blocks is
covered in the advanced section.)

•

Consider making the Basic SAR Map your default template:
1. In the Print window, open the Templates tab.
2. In the Default templates section, set Print/Export to Basic SAR Map.

Downloading Aerial Photos Before the Mission
•

During a search, Internet connectivity may be spotty (or non-existent.)

•

Use Copy Maps to Hard Drive to pre-load photos:
1. Open the File menu and choose Copy Maps to Hard Drive.
2. Set the Map Type to 1:12,000.
3. Experiment with Coverage to change the size of the grids – this will make individual
photos easier to see.
4. When using Uniform Grid or CD coverage, hold the CTRL key to get the hand tool when
over the grid area.
5. Selection is best done graphically:
⇒ White/Transparent: The map/photo has not been copied to the hard drive.
⇒ Gray/Shaded: The map/photo has already been copied to the hard drive.
⇒ Black/Solid: The map/photo will be copied to the hard drive when OK is pressed.
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6. Clicking on a map/photo already downloaded will turn the grid white/transparent – this
map/photo will now be deleted when OK is pressed.
7. When done selecting maps/photos, press OK.
•

Aerial photos download slowly. Expect up to 20 minutes per photo!

•

Do not download huge amounts of photos at one time. Go after common search areas
first.

•

Use Select All if you want to download the whole state. Even if you only complete a
portion, Select All can pick up where you left off.

•

Use a wired/high speed Internet connection to download photos.

•

When outside of Internet availability, turn off the Internet Access and Map Cache
Preference to Allow Terrain Navigator to connect to the Internet. This will save you
from receiving warnings, errors, etc. However, don't forget to turn it back on when you are
connected to the Internet once again.

Switching Coordinate Systems
•

Open File, Preferences, Coordinate to specify the Primary and Alternate coordinate
display.

•

The Primary Coordinate Display is shown on the tool bar, used as the on-screen and
printed grid, and used throughout TNP whenever coordinates are entered or displayed.

•

The Alternate Coordinate Display is shown only on the tool bar. This allows you to see
the cursor position in two different coordinate systems – useful when coordinating between
an air and ground team, etc.

•

When using Find Coordinates, the entry will default to the Primary Coordinate display, but
any coordinate system can be specified.

•

In the Print window, with the Map page block selected in the Properties tab, use the
Format drop-down list to temporarily switch between coordinate systems on the map page.

•

Available Coordinate Systems/Datums:
1. Dº M' S" – Latitude/Longitude in Degrees, Minutes, Seconds (NAD 27 or
NAD83/WGS84)
2. Dº M.M' – Latitude/Longitude in Degrees, Decimal Minutes (NAD 27 or NAD83/WGS84)
3. D.Dº – Latitude/Longitude in Decimal Degrees (NAD 27 or NAD83/WGS84)
4. UTM – Universal Transverse Mercator (NAD 27 or NAD83/WGS84)
5. MGRS – Military Grid Reference System in 1m, 10m, 100m, and 1km grids (NAD 27 or
NAD83/WGS84)
6. USNG – US National Grid in 1m, 10m, 100m, and 1km grids (NAD 27 or
NAD83/WGS84)
7. State Plane – In feet or meters. Commonly used in surveying. (NAD 27 or
NAD83/WGS84)
8. TSR – Township and Range (PLSS) in Township, Section and Parcel levels. (Datum is
N/A) Note: TSR is not available in all areas.
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TNP Mobile App Basics
•

For Android and iPhone devices.

•

Currently limited to a single license tied to registration account. Up to five devices can be
used.

•

Coming soon: TNP Enterprise for SAR teams. This will allow deployment over large
search teams and multiple devices.

•

Create a mobile account using File, Preferences, Project Synchronization.

•

Download the mobile app from App Store or Google Play.

•

Log into the app using account set up in File, Preferences, Project Synchronization (in
TNP desktop software.)

•

Use Project Synchronization in the Layers menu to establish a connection between the
active project on the TNP desktop and ones created on the handheld device.

•

Synchronization of markers, tracks, and geopins (photo, video, audio) currently supported.

•

Live tracking/team tracking not currently supported – but coming soon.

•

Internet connectivity required. Maps can be cached in advance on the phone, but
markers, tracks, etc. can not be synchronized without an Internet connection on both the
phone and the desktop.
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Part 2: Advanced TNP for SAR
Two-Window Mode
•

TNP can display two maps at once using Two-Window mode.

•

The two maps can be of different types (topographic vs. aerial), scales (1:24,000 vs.
1:100,000), and/or zoom levels (1:1 vs 2:1).

•

In most windows, there are two buttons to open maps. When no map is currently open,
the button to open the map will read Open and the other one will be disabled.

•

When a map is already open, the two buttons will read Replace Active and Open
Another. Press Replace Active to change the single map window to display the map area
you wish to open. Choose Open Another to create a second map window, which will
display the selected area.

•

When two maps are displayed, the two will read Replace Active and Replace Inactive.
Press Replace Active to change the map window that you were last navigating in to
display the map area you wish to open. Choose Replace Inactive to change the map
window that you were not recently navigating in to display the selected area.

•

You can also open a second map window by opening the Window menu and choosing
Split Vertically or Split Horizontally.

•

Another way to open a second map window is to press the Two-Window Mode button on
the compass control bar:

•

The amount of area displayed can be regulated by placing the cursor over the break
between the two windows, then clicking and dragging the mouse one way or the other.

•

Click in the desired window, then change the map type, scale, or zoom for the desired
effect.

•

The windows can be synchronized together such that the center of the two maps remains
constant while the other is moved. To do this, open the Window menu and choose TwoWindow Locked Mode, or press the Two-Window Mode, Locked button on the compass
control bar:

Using Range Rings
Range Rings are typically used to indicate a potential search area. Range rings consist of
one or more circles drawn out from a central point. Most commonly a range ring will be placed
at the LKP or PLS. These can establish a 300 meter hub, and/or mark percentages using Lost
Person Behavior from Koester.
•

To create a range ring:
1.
2.
3.
4.
5.

Click the range ring tool:
The mouse cursor will change to a series of rings.
Position the mouse cursor over the spot where you would like to create the range ring.
Click the mouse.
If desired, click and drag any ring to size it appropriately.

6. When finished creating range rings, switch back to the Drag tool:
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•

To move the center of a range ring:
1. Click the range ring tool:
(if not already selected)
2. Position the mouse cursor over the center of existing range ring. The cursor will change
to a move symbol.
3. Click and drag the range ring to the new location.
4. Rings can also be sized by clicking and dragging on the ring.

•

To prevent further movement of a range ring:
1. Right click on the range ring.
2. Choose Lock.
This is HIGHLY RECOMMENDED to prevent accidental movement of critical information.

•

•

To change the range ring properties – and enter Koester's Lost Person Behavior
percentages:
1. Right click on the center of the ring and choose Edit Range Ring.
2. Set the Number Of Rings to the desired amount. (Rings will be spaced evenly based on
distance or time.)
3. Set the spacing between rings to the desired amount – use Koester's Lost Person
Behavior tables, or set a fixed distance.
4. Don't forget to name the ring, and enter relevant notes.
To create a second ring that uses the same center point as another, but consists of a
different ring interval or color:
1.
2.
3.
4.

•

(if not already selected)
Click the range ring tool:
Click the mouse cursor near (but not on top of) the first ring.
Click and drag the center point of the second ring on top of the first.
Right click on ring's circle. Choose Edit Range Ring to adjust name, spacing, color, etc.

To delete a range ring: Right click on the ring (center or circle) and select Delete.

Using RBLs
Range/Bearing Lines (RBLs) are used to determine a bearing, plot a path (when the bearing is
given) and/or indicate the speed/direction of traveling objects (boat, plane.) Information can
also be displayed when two RBLs intersect.
•

To create a range/bearing line:
1.
2.
3.
4.

Click the range/bearing line tool:
The mouse cursor will change to an arrow.
Position the mouse cursor over the point of origin.
Click and drag the mouse, observing the range and bearing. Release when finished.

5. When finished creating range/bearing lines, switch back to the Drag tool:
•

To adjust the RBL:
1. Click the range/bearing line tool:
(if not already selected)
2. Position the mouse cursor over either end of the RBL (or in the center.)
3. Click & drag the RBL's origin, end point, or overall shape to the new location.
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•

To prevent further movement of a range/bearing line:
1. Right click on the range/bearing line.
2. Choose Lock.
This is HIGHLY RECOMMENDED to prevent accidental movement of critical information.

•

To change the range/bearing line properties – and enter specific computations for the
end point:
1.
2.
3.
4.

•

Right click on the RBL and choose Edit RBL.
Adjust the name, color, style, notes, and display properties as needed.
Set the specific coordinates of the start position (if needed.)
Set the end point of the RBL based upon coordinates, range and bearing, or time,
speed and bearing.

To determine the end point coordinates of a RBL:
1. Click the information tool:
2. Click anywhere on the RBL.
3. The Coordinates of the start and end points of intersection will be shown, along with the
range, bearing, back bearing, and start/end elevations.

•

To determine the point of intersection between two RBLs:
1. Use the drag (hand) tool to pan to the point of intersection.
2. Click the information tool:
3. Click on the point where the two RBLs intersect.
4. The Coordinates of the point of intersection will be shown, along with the range and
bearing of each of the two RBLs that intersect. (The range will be given from the start
point to the point of intersection, not to the end of the RBL.)

Using GeoPins
GeoPins are links to other objects (photos, word documents, web pages) placed on the map.
These can be used to map evidence, or gather additional information.
•

To create a GeoPin, just drag and drop the object from windows onto the map.

•

You can also create GeoPins using the GeoPin tool:

•

If the object contains georeferenced (coordinate) information (such as a JPG with EXIF
data in the header) TNP will automatically place that object in its place on the map.

•

If the object contains a time-stamp, but no coordinate information, it can be dragged and
dropped on a track. Provided the time encoded in the track matches that of the object, the
GeoPin will be placed at the corresponding position along the track.

•

GeoPins can be synchronized from the TNP mobile app to the desktop. This allows
links to be collected of photos, videos, and audio clips.

•

GeoPins are often Internet-based (such as those collected via the mobile app.)

•

The objects the GeoPins are linked to are not included as part of the project. This
includes backing up and sharing project archives.
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Using Overlays
Overlays typically consist of GIS (Geographic Information Systems) Data. These can include
boundaries, watershed information, trail systems, etc. While not often employed in SAR, certain
GIS files can be useful if available.
•

Finding Overlay Data
Overlays are usually encoded inside ESRI Shapefiles. A shapefile is a set of GIS data that
can contain all sorts of geospacial information. These data files are commonly available
from the GIS departments of local, county, and state governments. Generally speaking, you
can Google what you need, then import it into Terrain Navigator Pro as an overlay.
For example, a Google search of "Colorado Public/Private Land Ownership Shapefile" will
yield: http://trustlands.state.co.us/MapsandData/Pages/MapsAndData.aspx
On this web page a download is available for Surface Ownership data. Download this file
and unzip it. Note that a "shapefile" consists of a collection of files. These are matching
individual file names, but with .shp, .shx, .dbf, and .prj extensions. Ensure that all four of
these files are placed into a single directory. If one or more of these files are missing,
please check with the provider of that GIS data set.

•

Importing Overlay Data
1. Open the File menu and choose Import, Overlay. Open the .shp file (the other files in
the set will automatically be imported as well.)
2. Open the Layers menu and choose Overlays. Here you can specify how you wish the
GIS data to be displayed and labeled.

•

Other Overlay formats
The majority of GIS data that you will want to import will be in Shapefile format. Some data
may be in .DXF or .KML/.KMZ. These too can be displayed as overlays into Terrain
Navigator Pro - just select the appropriate file type when importing the data.

Advanced Track Editing
TNP includes several features for editing tracks. However, as a general rule, TNP considers
tracks sacred, so the tools are purposefully limited. This is done as to not corrupt the positions
recorded by the GPS.
However, there are times when tracks require further refinement. In these cases, it is best to
create a route from the track points, then use the route editing features to perform this
refinement. Of course, any editing should be logged in the notes.
•

To remove extraneous track portions:
1. Perform this operation only in consultation with the searcher – do not attempt to edit the
track without their direct involvement. Only he/she knows where the search began and
concluded.
2. Place the mouse cursor at the point on the track where the searcher defines as the
beginning of the search area.
3. Right click and choose Split. This will split the track into two portions, one on either side
of the split point.
4. Right click on the undesired portion and select Delete. The portion of the original track
from the split point will be discarded.
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Be very careful with the split/delete operation. These can not be undone and can cause
valuable search data to be lost.
Track splitting can also be used to snip out a portion of the middle of a track.
•

To remove portions in the middle of a track:
1. Right click on the start of the portion of the track you wish to remove and click Split.
2. Right click on the end of the portion of the track you wish to remove and click Split.
3. Right click in middle of the portion of the track you wish to remove and click Delete.

Tracks are inherently basic versions of routes. Thus, to perform advanced editing of individual
track points, create a route from the track.
•

To Create a new route from track points:
1. Right click on the track and choose Create Route.
2. Give the new route a Name.
3. To preserve all points (generally not recommended, see below) choose Create a
waypoint for each line point. Press OK.
4. Use Layer Size/Visibility to hide the original track. (Deleting is not recommended.)
5. Right click on the route and choose Edit Route. Consider turning off Display Waypoint
Symbols and Display Waypoint Names. Adjust line options (color, etc.) as desired.
6. Click and drag waypoints, delete them, add them – just like any route.

As part of the conversion process, consider thinning track points. Most times, track points are
too closely spaced together. This requires much processing by TNP (slowing performance) and
makes editing (as a route) nearly impossible.
•

When creating a new route from track points try: Create waypoints as needed to keep
route within 50 Feet of line.

50 Feet is within the tolerance of display of a USGS topographic map – and you will find that it
aligns nearly perfectly with the original track while making editing easier and improving TNP's
performance.
•

Right click on a route to create a track.
Sometimes it is desirable to "save" the route as a track again. However, be sure you
document your edits in the notes.
Creating a track from a route can also be very handy if you wish to display a route on a
GPS, but without waypoints showing.

More Symbols and Line Styles: The Emergency Management Symbol Pack
The tools in the Emergency Management SymbolPack are designed for firefighting, search and
rescue, and other emergency responders who rely on Terrain Navigator Pro for custom map
applications. By adding this module to TNP, a palette of hundreds of line styles and symbols
becomes available for quick and easy placement on TNP's topographic maps and orthographic
aerial photos.
The styles included with the EMSP are integrated into markers and routes.
•

34 Preset Fire Line styles including: Active Burnout, Helitanker Water, Proposed Dozer
Line, etc.
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•

81 Preset Fire Symbols including 32 Fire Category, 32 Fire Facility, 7 Fire Information, 5
Fire Protection, and 5 Fire Recreation symbols.

•

Floating Fire Drawing Tools Palette for easy access to all Fire Line and Symbol types.

•

Nearly 200 Emergency Response Symbols including 48 Incidents, 80 Infrastructures, 25
Natural Events, and 44 Operations.

•

Infrastructure and Operations ERS Symbols indicate Operational Levels of Full, Some
Damage, and Destroyed.

Useful Tips and Tricks
•

In 3D View, use Compass Control to move map. Click North arrow to move north, etc.
Also the blue box in the map overview can be positioned.

•

Regardless of the active tool chosen, pressing (and holding) the CTRL key on the keyboard
will temporarily change the mouse cursor to the Hand/Drag tool.

•

Use the clipboard functions in the Tools menu to copy/paste individual layers between
Projects. For example, click on a marker (using the marker tool), in the Tools menu, choose
Copy Marker, use My Projects to switch to a different project, then select Paste Marker
from the Tools menu.

•

If you want to copy/paste more than one marker (or route, track, etc.) between projects,
open the File menu and choose Export, Markers (or Tracks, Routes, etc.) Select the
desired layers and press Copy to Clipboard. Then switch projects and Paste (as above.)

•

Use GeoTips, as defined under Preferences, GeoTips to define the popups that appear
over street address, layers, coordinates, etc. These can be customized thoroughly to meet
your needs – such as displaying the notes attached to a marker.

•

Basic Undo is found in the Tools menu. This will revert to the last changes made. Keyboard
shortcut is CTRL-Z.

•

In each Edit window, found in the Layers menu (Edit Markers, Routes, etc.) is a New
button. Use it to enter layers by entering their coordinates. Do not Find a coordinate, then
place a marker – use the New button instead.

•

Be aware of special Print Templates, such as Last Print – in case you want to recall the
previously printed page block layout.

•

Right click on the map to open WebLinks – links to web sites that may be useful (weather,
mapping, etc.) that respond to coordinates. (Example: Get current weather conditions at the
mouse coordinate position.)

Advanced Printing
•

Page Blocks
Key to understanding the myriad of print functions is the concept of Page Blocks. Simply
put, a Page Block is an object on the printed paper. The map itself is its own page block.
Other types of page blocks can be added to construct the printed page.
Page blocks are created, changed, and removed using the Properties and Pages tabs in
the Print window.
Full desktop publishing is possible using Page Blocks.
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Press the Help button in the Print window for a full discussion on page blocks – or check
out the Terrain Navigator Pro printing tutorial posted on YouTube.
•

Switch map type/scale/zoom (size) in Properties tab whiile the Map Page Block is
selected.

•

When constructing a printed map (laying out page blocks), consider including:
1. Scale – Use the Scale page block, or include it in a Summary or Text page block.
2. North Orientation (True, Magnetic, Grid) – Use the Compass page block. Declination
can also be included in text and summary page blocks.
3. Operational Period or Date – Add these with text page blocks.
4. Mission Number – Use a text block (or create a label in the main map window.)
5. Time / Ops Period Valid – Add these with text page blocks.
6. Contour Interval – Can be included on the summary and/or text page block.
7. Ruler and Grid Lines: UTM, Lat/Lon, TSR/PLSS – Specify in the map page block.
8. Datum - Can be included on the summary and/or text page block.

•

•

Once you have your page laid out, save it as a Template for later use.
1. Lay out the page until satisfied.
2. Open the Templates tab.
3. Type a name and press Save.
4. Use the Templates tab to recall it in the future.
In Pages tab, use Include layer information pages to include a separate sheet of GPS
waypoints.

Advanced Publishing (Exporting) of Maps
•

The Print window has two modes: Print and Export. They work together to print and
publish maps.

•

When setting up a page to be exported (saved as a JPG, PDF, etc.) start by setting the
preview mode to <<Export Preview>>. This will allow you to see the precise map image you
are creating.

•

Set the desired image type (JPG, PDF, etc.) in the Printer/File tab in Save as type. When
creating a PDF, be sure to choose it as the Save as type. Use of 3rd Party PDF creators
(accessed in the Printer section) is not recommended as they have not been optimized for
use with TNP.

•

Images are not portrait or landscape. However, the width and height can be adjusted to
create that effect. For example, a “landscape” image would have a width of 11” and height
of 8.5”.

•

Once the preview mode, file type, and dimensions are set, configure up the map like you
would normally do. (Apply templates, page blocks, etc.)

•

Press Export to save the map image. You will be prompted for the file name.

Using TNP with Google Earth
•

Press Earth Button on toolbar:
Window Mode, Locked.

This opens a link to the Google Earth application in Two-
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•

Alternatively you can select Google Earth as a Map Type.

•

New markers, routes, tracks will be sent automatically to the Google Earth window.

•

Existing markers routes, tracks can be sent by right clicking on that layer and choosing
Send to Google Earth.

•

Google Earth requires an Internet connection; photos can not be pre-loaded.

•

Google Earth is a convenience feature, it could change (or be removed) as Google evolves
their product.

Sharing Layers and Projects: Basic Import & Export
•

Use File Import/Export to share Markers, Routes, Tracks.

•

Consider using GPX format (rather than MXF, TXF, etc.) for import/export – this increases
interoperability with other applications.

•

Use Export Active Project to transfer the entire project from one PC to another.

•

To Export a Project:

•

1. Use My Projects to open the desired Project. The active project name will be indicated
in the TNP title bar (the blue line at top.)
2. Insert zip/thumb drive into USB port
3. Open the File menu and choose Export, Active Project.
4. Highlight location of zip drive and click Save.
5. Detach zip drive and give to desired recipient (next Incident Commander, other TNPenabled team, etc.)
To Import a Project:
1. Obtain zip/thumb USB drive with Project (see above.)
2. Insert zip/thumb drive into USB port
3. Open the File menu and choose Import, Terrain Project Archive.
4. Highlight location of zip drive and name of Project and click OPEN
5. Project will show up on your computer
Note: Be careful not to duplicate existing Projects. Use My Projects list to keep track of
each Project. This is especially important over a multi-day period.

Advanced Connectivity: Project Synchronization
•

Automated project updating is possible using Project Synchronization in the Layers
menu. This links two projects together so that changes made in one copy of the project are
shared with the other.

•

There are two basic kinds of synchronization:

•

•

1. Text File – Used to synchronize on the same PC, or across a network of multiple PCs.
2. Mobile – Uses the Internet (cloud) to store changes, then share with desktop and
mobile devices.
Text file synchronization can be accomplished using a thumb drive. This could be used as a
“sneaker net” between two PCs at the command post when a network connection is not
possible.
Only basic information is synchronized (position, name, notes.)
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•

Synchronization Methods
The Synchronization Method is determines how TNP should interpret changes made to the
layers in a synchronized project. In it's most basic configuration, Full synchronization, any
change (addition, modification, or deletion) made on the TNP desktop will be reflected the
TNP mobile app. Likewise, with Full synchronization selected, all changes made in the
mobile app will be received into the corresponding project.
In most cases, Full synchronization will yield the desired (or most understandable) results.
Move a marker in the TNP desktop software, and it will also move on the TNP mobile app.
Delete a track in the desktop version of Terrain Navigator Pro, and the track is deleted on
the mobile app.
When you select a Synchronization Method, a description will appear that explains the
conditions under which changes (additions, modifications and deletions) will occur. Some
are "one way" (into the desktop copy of Terrain Navigator Pro only or sent out from it.)
Others, such as Full synchronization, are bi-directional, and changes pass freely between
the desktop and mobile app.
The methods available will differ, depending on whether or not layers already exist in this
project, the remote project, or both. For example, if the active project in Terrain Navigator
Pro already contains markers, it will not be possible to select a synchronization method that
receives (but does not send out) markers from a mobile device. Otherwise, the markers that
already exist will be immediately deleted - and replaced with only those markers that exist
on the mobile device (if any.)
As you can see, these various synchronization methods can be very technical in nature.
However, they are extremely flexible and allow for very interesting possibilities. A complete
list of Synchronization Methods can be found in the Help document that accompanies TNP.

•

To set up Text Synchronization between two projects:
1.

Create a common folder (network location, shared directory, thumb drive) that will
contain the synchronization files.
2.
Open the first project using My Projects.
3.
Open the Layers menu and choose Project Synchronization.
4.
Change Synchronize with to Shared Text File.
5.
In next pop-up, specify the folder location created in step 1 and press OK.
6.
In next pop-up, specify the desired synchronization method (usually Full
Synchronization, see above) and press OK.
7.
Press OK to exit the Synchronization window.
8.
On the other copy of TNP, open My Projects.
9.
Select either an existing project to synchronize with – or create a new one.
10. Change Synchronize with to Shared Text File.
11. In next pop-up, specify the folder location created in step 1 and press OK.
12. In next pop-up, specify the desired synchronization method (usually Full
Synchronization, see above) and press OK.
13. Press OK to exit the Synchronization window.
The two copies of the project will be linked together; changes made to one will be on the
other.
14. To break the synchronization link, open the Layers menu, choose Project
Synchronization, and change Synchronize with to Not Synchronized.
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Advanced GPS: Sending Markers, Routes, Tracks to the GPS
•

To send Routes, Markers, or Tracks to a GPS:
Open the GPS menu and choose Send to GPS, Send Route (or Marker/Track) to GPS.

•

Or right click on the layer (marker/route/track) and choose Send to GPS.

•

Don't forget to uncheck Connect in GPS menu when done with older Garmin Protocol
GPSs.

Advanced GPS: Creating Custom Maps
Most of Garmin's newer GPS models include a feature called Custom Maps. Terrain Navigator
Pro can create and manage these custom maps from the included USGS topographic maps
and Aerial Photos.This allows you to use the same high-quality maps on the computer and
GPS screens.
•

Most (but not all) Garmin Memory Card units support Custom Maps. Older Garmin
Protocol units do not.

•

Sending Maps to the GPS, the Basic Steps
1. Connect the GPS to the computer. If prompted (on the GPS) to go to Mass Storage,
press Yes. The GPS screen should now show a picture of a GPS plugged into a
computer.
2. Open the map (or aerial) you wish to send to the GPS. Open the GPS menu and
choose Send to GPS, Send Current Map. Give the map area a name and press "Send
to GPS." The map area that was on the screen will now be in the GPS's memory, and
ready for use on the GPS.
Note: There is a shortcut for sending the active map to the GPS: right-click on the map and
choose Send Map to GPS.

•

Editing the Map
In some cases, you may wish to transfer a larger (or smaller) map area to the GPS. In this
case, after choosing Send to GPS. After selecting the map to transfer, press Edit Map
(rather than Send to GPS.) An Edit GPS Map window will appear.
In the Edit GPS Map window, use the Coverage slider to show more (or less) map area.
Then resize the black rectangle in the Preview area to match the area you wish to send to
the GPS. (Grab the black box handles to resize or move the map area.)
In the Edit GPS Map window, you can also specify if you wish to have your layers (makers,
routes, tracks, etc.) embedded into the GPS map. For example, if you have used Terrain
Navigator's track tool to draw a trail on a topographic map, you may wish to have that trail
always displayed on the GPS's version of that map. Embedding this layer allows you to do
so. Note that all layers currently visible (as specified in the Layer Size/Visibility preference)
will be embedded. Thus, if you want to have some layers embedded, and not others, use
the Layer Size/Visibility preference to set up your map display to match.
Note: Even though the preview will switch to the major roads when the Coverage slider is
all the way to the right, the final map will contain all the streets.
TNP can also include a GPX file of Markers, Routes, and Tracks along with your GPS Map.
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•

Manage GPS Maps
Because of the limitations on custom maps imposed by Garmin (more on this later) TNP
also features a window that allows you to effectively manage your map content. This
window is accessed by opening the GPS menu and choosing Manage GPS Maps (or by
pressing Save and Manage in the Edit GPS Map window.)
The Manage GPS Maps window presents a list of the maps you have created (using Send
Map to GPS.) When you send a map to the GPS, a copy of this map is kept automatically
by TNP. This can save you time in the future, should you need to remove custom maps
from the GPS. The left side of the Manage GPS Maps window shows the maps that you
have created in TNP shows the maps that are currently stored on the GPS.
To send a map to the GPS, highlight it in the list of Available Maps, and press Send to
GPS.
The list of Available Maps also has buttons that allow you to Delete the selected map,
retrieve Information about that map (such as its scale, dimensions, and number of tiles),
Rename the map, Export the map (as a KMZ file for use in other applications), or to Send
the map to Google Earth for viewing. Use these buttons to manage your collection of
custom maps within TNP.
The list of Maps in GPS can be configured to show the maps in the GPS, on the external
memory card, or both. Unless otherwise specified, maps sent to the GPS will automatically
be sent to the external memory card (if installed.) You can also remove the maps from the
GPS and get Information about the selected map.

•

About Tiles
Tiles are portions of map data. On a 1:24,000 USGS topographic map, one tile can cover
just over 3 square miles. (Other map types and scales will vary proportionately.) Garmin
has placed a restriction in most of its GPSs that only allow 100 tiles of custom maps to be
displayed. (The newer Garmin Montana features a 500 tile limit.) It is important to note that
this is not tied to the memory of the GPS, but rather its processing ability. Terrain Navigator
does not create this restriction.
As you create your library of GPS maps, use the Information button to note how many tiles
each map contains. The display on the right will update in real-time with the number of map
tiles that the GPS currently is holding. Once this number is exceeded, TNP will warn you
that the GPS may not display the desired maps.
We have discovered that the GPS favors maps stored on the SD Card before those kept in
internal memory. Thus, if you have an SD card with 90 map tiles, and also have 20
additional map tiles in the internal memory, all of the maps on the SD card will be displayed,
while half of the maps in the internal memory will be ignored. (Note that Garmin may
change this functionality as they continue to revise and improve their products.)
If you prefer to think about your storage in terms of the number of 1:24,000 topo quads you
can store on a Garmin GPS, the typical quad is 54.5 square miles. This yields a capacity of
18 quad sheets on GPSs with a 100-tile limit, and a capacity of 90 quad sheets for those
GPSs (such as the Montana) that have a 500-tile limit.
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•

Using Custom Maps on the GPS
The Garmin GPS unit picks the "best" map available at any given zoom level. In the event
that the GPS navigates outside of the custom map area, it just grabs whatever map is best
at that spot. This could be the base map data, or other map data that was loaded.

Advanced GPS: Using Uncommon GPSs
•

Check the manufacturer and model in GPS Setup in the GPS menu, then proceed using
the rest of the items in the GPS menu.

•

Check the configuration notes in the GPS Setup window. These often contain help
specific to particular GPSs, in great detail

•

Still not sure, try the GPS Setup Wizard in the GPS menu.

•

Some GPSs now Import/Export GPX files directly (these include Delorme and Magellan
units.) Connect to PC and Import (File menu) the GPX file – The GPS will appear as a USB
thumb drive.

Advanced GPS: Live Position Tracking
•

TNP can be used as a moving map display in a vehicle; displays your current position on
the USGS topo map or aerial photo.

•

To get started, open the GPS menu and select GPS Tracking, Start Tracking.

•

Specify Tracking Preferences for symbol, rate of update, etc.

•

A track log can be recorded. Open the GPS menu and select GPS Tracking, Record
Track to create a track log while navigating.

•

Power drain is likely, consider using an inverter.

•

Don't drive and run TNP at the same time.

•

Consider using USB GPS "Puck" or "Mouse". Bluetooth (and solar) GPSs exist. Any NMEA
compatible GPS will work. These are often more convenient than repurposing a handheld
GPS.

•

Can also do a simple lookup of current position. Open the Find menu and select GPS
Location.

•

When complete, open the GPS menu, uncheck Connect. Otherwise TNP will continue
attempting to communicate with the GPS.

Connecting with TNP Mobile – an Alternative to Handheld GPSs
Use Project Synchronization to set up communication between the desktop and mobile
versions of the Project. Once configured, changes made on the desktop will be reflected on the
mobile device. Likewise, changes made on the mobile app will be shared with the desktop
software.
•

When you have a project on the desktop that you want to synchronize with the mobile
device:
1. Open the Layers menu on the desktop software and choose Project Synchronization.
2. Change Synchronize with to Mobile Terrain Navigator Pro Project
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3. You will now see a list of Projects that have been created on the mobile device (if any.)
Select an existing mobile project to synchronize (share markers and tracks) with its
desktop companion. Or, press New to create a new project on your mobile device, and
select it. Press OK.
4. For the available method, you are generally best off using Full synchronization. Select
it and press OK.
5. Press Close to exit the Project Synchronization window. Changes made on the desktop
software in this project will now be reflected on the mobile device. Likewise, changes
made on the mobile version of this project will be reflected on the desktop.
•

•

•

When you have a project on the mobile device that you want to synchronize with the
desktop:
1. Open the Layers menu on the desktop software and choose My Projects.
2. Select the project that you would like to share with the mobile device. If you wish, you
can create a new project.
3. Open the Layers menu on the desktop software and choose Project Synchronization.
4. Change Synchronize with to Mobile Terrain Navigator Pro Project
5. You will now see a list of Projects that have been created on the mobile device. Select
the existing mobile project to synchronize (share markers and tracks) with its desktop
companion. Press OK.
6. For the available method, you are generally best off using Full synchronization. Select
it and press OK.
7. Press Close to exit the Project Synchronization window. Changes made on the desktop
software in this project will now be reflected on the mobile device. Likewise, changes
made on the mobile version of this project will be reflected on the desktop.
Currently, the layers supported by the Terrain Navigator Pro mobile app are limited to
Markers, Tracks, and GeoPins. Thus, only these types are synchronized between the
desktop software and the mobile app. Moreover, GeoPins can only be received from the
device, but not sent to it. Thus, you can take a picture in the field using the Terrain
Navigator Pro mobile app and send it to the Terrain Navigator Pro desktop PC, but you can
not send a photo from the PC to the mobile app.
Synchronization is limited to the core elements of each layer: name and position. Additional
elements (color, symbol used, etc.) are not shared.

Team Tracking
Team Tracking allows real time (or near real time) position reporting from the search team to
the base station. Positions are recorded in a route (one per team/tracking device) so to allow
flexibility in display.
•

InfinityGear and Pryme GPS microphones “plug and play” with Team Tracker. Each time
the microphone is keyed, a “chirp” is sent to the base station and the team’s location is
updated in TNP.

•

Team Tracker can also be connected to other devices using the NMEA specifications for
waypoint transfer. This allows for team positions to be updated through APRS and other
custom solutions. See the TNP technical documents on the web site for more details.

•

Team Tracking is coming soon to TNP Enterprise and TNP Mobile apps. However,
Internet/Cell service will be required to obtain the tracking signal.

34

